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Install CanWay

Step 1 — Implement CanWay Installer.exe

Step 2 — select language

P

Select Setup Language

mmpm  installation:

(=]

&' Select the language to use during the

-

[English

~)

Ok ] [ Cancel

)

Step 3 —select NEXT

Step 4 — select your folder and click Next

B3 Setup - CanWay

Select Destination Location
Where should Canway be installed?

—J Setup will install Canw'ay into the Following Folder,

To continue, click Mesxck, IF you would like to select a different Folder, click Browse,

| Z:\Program FilesiCan

gy

| [ Browse, ..

Al least 21,2 ME of free disk space is required.

< Back ” Mext = l[ Cancel




Step 5 — Select Additional Tasks (USB driver ) and click Next

B3 Setup - CanWay E”E|E|

Select Additional Tasks
Wehich additional tasks should be performed?

Select the additional tasks you would like Setup ko perfarm whils installing Canitay,
then click Mesxt,

Additional icons:

[] create a desktop icon

< Back “ Mexk = ][ Cancel

Step 6 — click Finish .



Open CanWay and Read GPS Log From Device
Step 1 - open CanWay and import your reference data.

B3 Create New User

Create New User

This wizard swill quide youo through the steps of
create new user

Back | Mext j[ Cancel




B8 Create New User

Who are you ?

Flease enteryaur basic persanal infarmation

Marme

Sex

Birthday

|

X

B8 Create New User

Display Unit

choose your default displaved unit settings

LInit of Measurement

(%) Metric iMeters, Kilometers, Kilograms)

) Imperial (Feet, Miles, Pounds)

() Mautical (Feet, Mautical miles, Pounds)

Show |atitude [ Longitude

() Decimal Degrees

{(*) Degrees, Minutes, Seconds

() Degrees, Decimal Minutes

war
|user
& Male
) Female
| 1983 Yesar 2 Month 4 Day »
[ Back ][ Ml et ][ Cancel]
3
P
Back H Mext ][ Cancel




B8 Create New Oser

Calories Setting
Please enteryour height and weight

Height |

Weight |

-
170| cm
70| ky
Back ][ M et ][ Cancel ]

B3 Create New Uszer

Activity Groups
Choose your activity groups

Running
Yialking
Matareyeling
Swirrming
Canoeing
Skiing
Travel
Other

Back

I

[ et

] [ Cancel




Create User Finish

You have nowve finished the Wizard, please click
"OF" to close the Wizard and start to use the
sofhware.

User management can modify or switch user for “File” -> “user Management”
and -> “Switch User”

Step 2 — Connect Data Logger system to PC USB port. Please make sure the
Data Logger power is turn on.
Step 3 — Menu command “Logger” -> “Download Trip” or click \%

CanWay will automatically detect the com port and baud rate, then read in the
GPS tracks.

Dowaloadiag the trips (T

A track list window will be popped up. Select the tracks to import.




B3 Add Activities Wizard

Select activities to import

)
)
=
@

2012-11-25 08:56
2012-11-25 0914
2012-11-25 09:41
2012-11-2515:41
2012-11-2517:03
2012-11-2517:55
2012-11-26 09:43
2012-11-27 11:43
2012-11-27 12:36
2012-11-28 09:49
2012-11-2819:43
201 2-11-3014.36

REHEHREEEEREE

Distance (K

Time
0.73
12.14
14.71
7.55
G.58
2.45
n.0z2
0.04
0.1z
0.20
16.97
010

03:20
14:40
2706
14:20
14:58
14:85
38:30
0a:30
5:16:30
Taa41
26:24
28331

>

[ £

Total selected 41741

Back

| T Met ] | cancel

Tracks will be shown on the Map window.
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Clear Data Logger Memory
Menu command “Logger” -> “Clear Trip” will clear the data stored in device, so
the device memory are enough for next usage.

-,

GPS Photo Tagger >

\‘..:) Are wall sure you wank ko clear all daka?

Data Logger Configurationu=:

Connect Data Logger to PC and turn on Data Logger. Menu command “Logger” ->
“Configuration” If Data Logger is not connected, the GPS Log Setting area will be
disabled. Please make sure the Data Logger power switch is turn on when connect.

Connection Setting:

B8 Logger Confignration @

GPS Logger COM Port |m v| [ Connect ]

Log Mode

) By Time | | secands

{(*) By Distance |EI.IZI1 | meter

Minurmum Logaing Speed |IZI | kmrh

Used Mermory 10 | [ clear]

13%

[ Ok H Cancel ]

Auto Scan GPS Module (Recommended)
The program will automatically detect the com port and the baud rate. It is
recommended to set to auto scan.



GPS Log Configuration

There are 4 log modes: General mode, vehicle mode, cycling mode, and
hiking mode. Users can also change the default setting of these 4 modes.

Log mode setting: By Time or Distance
Log By Time (seconds):

Specify the log period. For example, if specify 3 seconds, the GPS device will log
every 3 seconds.

Log By Distance (meters):

Specify the log distance. For example, if specify 10 meters, the GPS device will
log every 10 meters.

Minumum Logging Speed: over () km/h:

Specify the log speed. For example, if specify 20 km/h, the GPS device will log
when the speed is over 20 km/h.

Note: GPS device will log only when the log period or log distance, and meet the log
speed with the criteria.



Data Log Memory

A bar show how many percentage of memory is used in the Data Logger

(b
=

device. Users can use “Clear Trip” == to clear all the memory.

When data logger memory is full , the device will stop logging. please clear the
memory.

Track List Window
Select Track line, Map window will animate the whole trip by moving the current position. And also
display the summary data, graph window and photo information.

Track

Track Name Start Tirne End Time Distance (km} Duration
2012-11-25 08-56 2012-11-25 0856 2012-11-25 08:589 078 03:20
2012-11-2509-14 2012-11-2509:14 2012-11-2509:29 12.14 14:40
2012-11-25 09-41 2012-11-25 09:41 2012-11-2510:08 14.71 27:08
20M2-11-2515-41 2M211-2515:41 2012-11-2515:56 T.55 14:20
2012-11-2517-03 2012-11-2517.03 2012-11-2517:18 6.58 14:58
2012-11-2517-658 2012-11-25 17658 2012-11-2518:10 245 14:85
2012-11-26 09-43 2012-11-26 09:43 2012-11-2610:22 0.0z 38:30
2012-11-27 11-43 2012-11-27 11:43 2012-11-27 11:51 0.05 og8:30
201 2-11-27 12-36 2012-11-27 1236 2012-11-2717:82 012 A16:30
2012-11-28 09-49 2012-11-28 09:49 2012-11-2817:44 0.20 78041
2012-11-28 19-43 2012-11-2819:43 2012-11-28 20:09 16.97 26:24
2012-11-30 14-36 2012-11-3014:36 2012-11-3017:30 010 283
2012-12-01 08-03 2012-12-01 08:03 2012-12-01 09:39 74.47 1:35:54
2012-12-02 16-M1 2012-12-02 16:01 2012-12-0217:04 62.47 1:03:52
N1 71703 NA.A NN Na AT M1 NTNA-ARR nnn na-24

User can clear track from “Track” -> “Delete Track” or click .

1. Select Track List, and select your Track . you can change Category for other sport.



Summary | Gpeed/ Elevation | Phato |

Name 2013-01-05 20-47 |
Categary Biking Vv
Location | |
Distance |?5.45 km | Climb |413.EBI—4E?.14 |
Duration |11':'1 04 | Stap |I34:21 |
Avy, Speed |”-1 4 kmih | Pace ||:|349 minfkm |
Max. Speed |135.?1 krih | Min. Pace |n:25 minfkm |
Calories 0.9 Keal |

Weather | |
Equipment | |
Notes

2. Select Photo Explore .User can find photo list.
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3. Select Facebook .User can login Facebook.

EIEX

B CamWey - nser

Bk Logger  Toch Flok Tool - Haly

[k g o B EE% JEE RIS R

Tratk List | Fhafo Explora Facshneis |
£ Facebook

Liag i 5o use yor Facsbapk aooound vwith Cariday.
Ema or Phane: | bestfhora oo

Faszaord:
[ <zen fe laoged in

Freigal your posnsid?

Skgn up bor Facebook m Cancel

Add Photos@

Users can add photo from a file folder.

Add photo from a folder: Menu command “Photo” -> “Add Photo...” ->
“From Folder”. Select a folder to add photo.

The photo will show on the Photo View window. Users can add comments
to each photo. Users can also rotate, delete photo.




Track st | Pnoks Equiors | Facebork

i ming 7 L,

& Runsing Tragk Noms

L ‘Walerg (T4 I 72-0 1537
L woteeepchog (i 21230 156
I Ennmnr:lltt' W2 1N
b Camicieg i) MBI AT

i s saanon e
b Trasi i . 2 .,.\
4 Oteran 30901322

201301.01 2145
ARSI RN

Summar | 8peas i ERmatias | PN

WINTIS M98 18

Twd  Valiw

Name 0121330
() 012923
Lawude 297 109494
Lorgit .. 121° 249E

‘ﬂ |
“

Bt Time
M%7
1212302356
W22
2121700
201301811138
W00 0322
A 0141 1143
WAL

Wi Eat

Fnd Tiree
WFATW|ITH
1124231 0108
0133231 13458
29231 1352
3013-21.01 1143
0130100 13:45
0130101 2328
I 1P1-04 2144

Digtsnce Jam)

90
159
10
T80
n
anm
Pl
34097

Curstan
2T H
AR LRy
M0
26202
[0
349
451
mn

When photos are added, CanWay will automatically match photo and GPS

logged waypoints by time. Place marks will be created as a placeholder for

photos.




Browse photos

Click on the “next photo” and “prev photo” buttons to browse the photos.

Current photo and current place mark will be synchronized.

Barymary | Speed/Eksyxn Pt

‘M et
: H |
|

MNZNN5.  MNMIS. WNZNIE. MNDE.  WINZAIE.

| bead ‘*.‘
Fian Ve

Nim AN 150
DokeTime 21212002042

Ly WAEN f ’ -‘ .
leeghits  1M°36550F { PR Sl 5 Synchromzed

'M"

Photo List Window

Photo list window will show the attributes of photos. The information includes
“file name”, “date”, “place mark”, “latitude”, and “longitude”.

Field Value

Marme 20121230_14936...
Date Time  2012-12-3023:36
Latitude 257 10.8548'N

Longitude 121" 24.9870'E




Upload Photos to face book.

ICONn > “Upload Photos facebook” , Select picture and Click next.

B3 Upload to Facebook

Upload Photos
Selectwhich photos will upload to Facehook

----- 1@ pic (26

20121230 1567 20121230_15[¥]

[

Field Walue

Mame 201212301,
Date Ti... 2012-12-31...
Latitude 25" 17.8610'N
Langitu... 121" 34.921.

50° 30.8055' M, 847 01.4062'E

Back Mest | [ cancel




Google Earth Viewing!

Command “File” -> “View in Google Earth” will invoke Google Earth to view
the tracks and photos. Users have to install the Google earth.
http://earth.google.com/

= Google Farth
Dl B ¥ae Isok A0 Help
¥ Search

u || Search

W ptegs sy HYC

Gl Duechons  Hizhory

¥ Places
B VT My Placer A
= Fley Temgoory lauces
= Lg CanWey hug
= Z]E thobe:

2012123 153668,
3033-12-302336

4] & 20121230 154252,
2§2-12-30 2342

B [+

» | ayers Earth Gallery >

Save As KMLFile g and KMZ
Menu command “File” -> “Export as Kml...” to save the tracks and photos in
kml file. You can import kml file to Google Earth. You can also send kml file to
friends to share their trips with friends as long as they have installed Google
Earth on their computers.


http://earth.google.com/

Export Track(s)...
Menu command “File” -> “Export Track(s)...”

Step 1. Select the tracks to export.

Step 2. Select the export file format. “CSV”,“GPX”, “NMEA Text”, “Google Earth
KML”, and "Google Earth KMZ” file formats are supported.

Altitude / Speed Graph

Switch to “Speed/Elevation View” window will show the Elevation and speed
graph. You can change the Y Axis or X Axis data unit with the graph.

Summary | Speed i Elevation Phatal

Y AxiS |Speed
W s O Time (® Distance

N Ml

4m

A VILR
-1 1l | |

40.00 WH

Speed

20.00

0.00 - T T T T
0.00 20.00 40.00 60.00 20.00

Distance




Track Editing
Select Track line, Switch “Editor” on the map window. Move the cursor on the
track will show the preselected waypoint time. Click on track to select the
whole track.

Wap | Edt

 tpar st - g BN Tpar annac e : o AT ALGEIRN1 21 30008 E

Time Zone Setting
There are two time zone settings in “CanWay”. One is “Photo time zone”, the
other is “Display time zone”. “Photo time zone” is set to the same time zone of
your digital camera. The “Display time zone” is set for displaying purpose. For
example, If you are an Englishman and you travel to United State. The “Photo
time zone” should be set to “England” because your digital camera time zone
is in England, and the display time zone should be set to “United State”.

The “Photo time zone” by default is set to the PC default value. In most of the
case the default value is correct.



User can set up Track Time Zone . Click on track to select track List >
Summary> Time Zone.

B3 CamWay - nser
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User can set up Photo Time Zone . Click on track to select Photo Explore>

pic>Photo>Adjust Time Zone
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B3 Adjust Time Zone

Titne Zone (GMT+08:000 Taipe

Ok || Cancel |




Options

Menu command “Tools” > “Options...”

Profile :

Data : Sex, Birthday , Height , Weight ,Location, Week Start on

B8 Preferences

Llser |hen

|

P

Sex

Birthday
Height
Weinht
Location

Week Start on

) Male i) Female
|19=33 Year 2 Morth 4 Day v|

| 170.00| cm
| 70.00| kg
| |
|5undaﬁ,r v|

O

] [ Cancel




Distance unit:

Data : .GPS Location, Distance, Elevation , Height , Weight , Energy , Temperature

B3 Preferences [E'

Lser |ben v|

GPS Location |Degree Minute Second V|

Distance |Ki|nmeter V|
Elevation |ru1|ater V|
Height Centimeter v/
Waight Kilograrn v|
Eneray |Ca|nries V|
Termperature |Ce|sius V|

O

] [ Cancel




Route:

Data : Separate Routes Criteria, Route Thickness, Route Color .

B8 Preferences

ser

|

Route Thickness

Route Colar

| Photo | Category Zones |

x]

Seperate Routes Criteria |1 1]

| (0-65535) minutes

O

] [ Cancel




photo:

Data : Group Photo Criteria, Time Match Criteria .

B8 Preferences

Llser |ben

|

Group Photo Criteria

Titne Match Criteria

(0-255 meters)

120 (0-65535) seconds

O

] [ Cancel

x]




Category Zones :

B3 Preferences

Lser |user v|

| Profile | Unit | Route | Phota || Category Zanes |

Major Categories |Pace!5peedznnes V|'C§}F'EIEE (O Speed (knfh)

Biking Category Mame |Running |

: Zone Narme | LSL UsL color | [
Walking 3:00 ] @
Jogging B:00 .00
Running 0:00 o0 [

fone Mame |Wa|king |

Range |9:EIEI | ~| | rminfkm

e

| [ Ok ] [ Cancel

— - _ d




Sport Analysis :

s

1 Activity view :L==with the graph window
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Analysis data : Summary, Splits , Speed , Pace, Elevation .



1.Summary : include Name , Category, Location, Distance , Duration,
Avg.Speed , Max.Speed , Calories , Wealther .

_____ 5 ummanr Splits | Speed | Pace | Elewation
Marme 2013-01-01 21-43
Category Biking
Location
Distance |26.18 km | Climt [ 166 85226 55 m
Duration | 45:51 | stop [1035
vy, Speed [34.27 kmih | Pace | 1:45 minfkm
Max Speed |81 70 kmih | Win. Pace |IZI:44 Frindkm
Calories [0.7 Keal |
Weaather
Equipment

MHotes



2. Splits :User can change Distance and Chart Type .

| Bummarg.r| Splits |8peed || Pace || Elevatinn|

Split by Custom Distnace v| 1.00/ kn
Time Time Time Time Time Time Time Time

02:00 1.00 02:00 1.00 700 +0:00 07

05:20 7.00 0315 1.00 315 #1115 +0:37

06:05 R 00:40 0.27 737 047 010

Chart Type Time (accumulate) L

06:40

03:20

Time

01:40




3. Speed :User can change Zone and Chart Type

| Surnmary | Splita[ Speed |F'a|:e | Elevation |

fone Funning W
fone Speed Speedyvs Avy. | Distance Time Distance Percentage | Til#™
Walking £.09 -28.18 0.a7y 05:35 22%
Jogging 6.72 -27.85 010 00:545 0.4 %
Running 4824 +1.3.97 2547 a1:41 973 % 3
Total 3427 +0.00 2618 45:51 100.0 % b’
Lt ¥
Chart Type Speed / Distance v|
&0.00 1
60.00 { I
=
E |
=z
L]
L]
[
w
20.00
R unring
VWalkjng
0.00 T T T T

0.00 5.00 10.00 15.00 20.00 25.00




4. Pace :User can change Zone and Chart Type

Running

| Elevation |
fone Funning w
fone Face Face vs Avd. Distance Time Distance Percentage | Tin#™|
Wialking 21:46 +20:01 0.61 1315 23%
Jogging 255 +7:10 010 0085 0.4 % g
Running 114 -0:30 2547 3141 7.3 %
Total 1:45 +0:00 2618 4551 100.0 % ]|
Bl il ] B
Chart Type |PaceIDi5tance w
10:00 4
WE 1 ngl l
E 54[] | P IR EEE S <M 1! ¢+ H1fr r r r 1
=
=
E
i
=
o 3204

0.00

5.00




5. Elevation :User can change Zone and Chart Type

Summary | Splits | Speed | Pace | Elevatiun|

Elevation field of ® GP3 O Earth Surface
fone Standard w
fane Elevation Cha...  Distance Tirme Distance Percentage | Time Percent #*
Ascending +16E.835 438 11:36 16.7 %
Flat -0.30 16.20 2314 61.9 %
Descendi... -228.499 561 12:00 21.4 % B
Tatal +0.00 26.18 4551 100.0 % 1%
< | 2
Chart Type Elevation f Distance w
60.00 -
E
= 40.00
=
w
=
L
Ll
20.00 1
0.00 . . . A /j\ . {
0.00 5.00 10.00 15.00 20.00 25.00




2. Report View :li] User can select Search Criteria, Data Field , Time out,
Caterrory .
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1. Search Criteria : User can select time range .

All w

Thiz WWeek

LastW™eelk

This Manth

Last Manth

Past Maonth

Past 3 Maonths

Past 6 Months bl




2. Data Field : User can select measure conditions .

Data Field | Total Distance w
A
Total Time 1
Moving Time
Calaries

Total Ascent

Total Descent
Average Speed
Maximum Speed b

3. Time out : User can select Time Unit .

Tirne Unit | Activity W

4. Caterrory : User can select Sport mode .

Categgory | All w

Walking
Motorcyeling
Swvirmrming
Canaoeing
Skiing
Travel

Cither 3

Al K4
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